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The Power of “Deep” 8-Bit Masks (fig. 1) - If you look closely at these two
icons, you can see how the background pattern of the desktop shows through
the translucent areas. This is accomplished by setting different opacity levels in
Photoshop layers and using them as the icon’s mask data. Experimenting with
these methods can create some exciting effects on the desktop.

An Introduction
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What Is IconBuilder Pro?

IconBuilder Pro is a filter for use with Adobe Photoshop that makes it easy to create professional
looking icons. IconBuilder Pro combines the power and flexibility of Photoshop with the ease of
the Mac OS to make a powerful icon creation tool for both beginning and advanced users.
IconBuilder Pro has the ability to construct and save icons for all of the Macintosh (7.5, 8.5, 9.x,
10.x) and Windows operating systems (95, 98, NT, ME, 2000 & XP), and even lets you convert one
platform’s icons to the other effortlessly.

Written by veteran Photoshop filter author, Craig Hockenberry, IconBuilder Pro is an ideal "real
world" solution for quickly and easily translating any kind of transparent effect done in Photoshop
layers into icons for Mac OS 8.5, Mac OS X, Windows XP and beyond.

IconBuilder Pro System Requirements

• Mac OS 10.1.3 (or later) is recommended
• Adobe Photoshop 7.0+ or Adobe Photoshop Elements 2.0+
• Screen resolutions at or above 800x600 pixels

IconBuilder Pro Feature Summary

• Creation of true 32-bit icon formats for Mac OS X and Windows  XP
By combining custom icon data (that you create or import) with 1-bit or 8-bit
transparent masks (fig. 1) from Photoshop layers, IconBuilder Pro can create transparent
icons on the desktop in a matter of seconds.

• Creation of desktop “icon states” in Mac OS X
IconBuilder Pro supports the creation of “icon states” which were introduced into Mac OS X
10.2 (Jaguar). For instance, you can create a folder icon that appears to open when an item is
dragged onto it or make an application icon that highlights when clicked.

• QuickConvert icons from Mac to Windows and back again
Quickly and easily convert one platform’s icons to the other in a single click. IconBuilder Pro
keeps only the resources you need and discards the rest to optimize the final icon.

• QuickBuild™ creates all icon resources in a single click
Filling the resource grid is simple using the included Photoshop Action and QuickBuild™ button.
You can create a final icon in just a few clicks.

• Extract any icon (including its mask) into Photoshop for editing
This is useful for examining an existing icon’s masks or for editing the lower bit depths of an
icon that has already been created.

• Export Macintosh .icns files for use in software applications
Developers can export Mac icons as .icns files for use with standard coding tools like Apple’s 
Project Builder.

• Resource protection eliminates unnecessary sizes and bit depths
Resource protection helps keep the file size of an icon as small as possible by eliminating
resources that are not needed for the target platform. This is especially useful when building
modern 32-bit icons.

• Ability to view icons against various background colors and textures
View your icon against multiple background patterns and colors including the default
choices that accompany Mac OS X and Windows XP.

A Note About The User’s Guide

Throughout the User’s Guide you will notice color coded words. The Blue highlighted words
represent actions. Orange highlighted words represent locations.

It is important to realize that IconBuilder Pro is not an icon editor in the traditional sense.
IconBuilder Pro is a construction tool you can use to quickly assemble various resources you
have prepared in Photoshop. There is no other icon editor currently available that matches
the power of Photoshop for creating and editing bitmap graphics. The combination of
IconBuilder Pro with Photoshop is the best method to create icons that meet the demands
of modern operating systems.
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What Is An Icon?

From a technical point of view, an icon is simply a collection of bitmap graphics (resources) that
have been collected and saved into a single file. This file is read by the operating system and the
best (or most appropriate) resource is selected and displayed to the user. Icons can represent files,
applications, folders, actions, and more. They are displayed either on the desktop or within a
program, such as on an application’s toolbar.

On a much deeper level, icons represent concepts, things or ideas. Icons are the primary way that
users interact with modern operating systems. They can represent something as simple as “Print
this document” or as complex as “Add new employee to human resource database” and anything
in-between.

Resource Sizes & Bit Depths

Different computing platforms have different requirements for displaying icons correctly. For example,
the large format (Thumbnail) icons introduced in Mac OS X are not used by Windows and are not
needed when creating icons for earlier Macintosh platforms. Refer to figure 2 to identify what
specific resources you will need to include when building an icon for a specific platform and
operating system.

Traditionally, icons are designed to work at 16x16, 32x32, 48x48, and 128x128 pixel dimensions.
The 16x16 size is typically used for list or detail views. For many years, 32x32 was the defacto size
for desktop icons and most icons are still designed around this size. Windows based machines are
typically where 48x48 pixel icons are used most. Lastly, Mac OS X introduced 128x128 pixel
(Thumbnail) icons into the mix. There are additional icon sizes on both platforms, but these are
the main resource sizes you will need to be concerned with when building desktop icons.

Bit depth refers to the number of colors an icon resource can contain. This is directly related to the
screen resolution setting on the user’s computer. A 32-bit icon contains millions of colors as well
as an 8-bit (256 gray level) mask. Mac OS X and Windows XP rely heavily on 32-bit icons to achieve
their modern appearance. “Classic” operating systems like Mac OS 9, Windows 95, 98, NT & 2000
primarily use 8-bit (256 color) icons. The Macintosh platform generally does not use 4-Bit (16 color)
icons, but millions of Windows users have their displays set to show icons in 16-color mode, so
designing proper 4-bit resources for Windows is critical. Lastly, 1-bit icons are used only on the Mac
side, and only on certain occasions.

Data + Mask = Icon

An individual resource contained within an icon is basically made up of two parts: the icon’s data
and the icon’s mask.

The data is simply the bitmap image itself, or colored pixels arranged in a way that forms an image.
The data can be drawn by hand, drawn pixel by pixel, or created using any number of vector-based
drawing programs such as Macromedia Freehand or Adobe Illustrator.

An icon’s mask is the information the operating system uses to tell what parts of a resource should
be displayed as transparent and what parts should be opaque. In classic operating systems, masks
had pixels that were either off (transparent / white) or on (opaque / black). With the advent of 32-
bit icons in Mac OS 8.5 and Windows XP, it became possible to have a mask with 256 levels of
gray. This means that a pixel that is 50% gray translates to a pixel that is 50% opaque in the mask.
With these “deep masks” it is possible to achieve smooth drop shadows, anti-aliased edges, and
transparent or translucent masking of an icon. (fig. 3)

IconBuilder Pro simplifies creating a mask. The transparency information that is contained within
a Photoshop layer is read by the filter and automatically converted to become the icon’s mask. This
saves time and effort and allows you to adjust opacity settings on layers to acheive some very cool
results. We encourage you to experiment with masks and the design possibilities they represent.

Icon Resource Comparison Chart (fig. 2) - This table of icon resources will
help you determine what sizes and bit-depths you will need when creating your
icons. IconBuilder’s Resource Protection feature helps you to know which sizes
and bit-depths are unnecessary by locking them out of the construction grid. This
optimizes the final icon and helps keep file sizes down.

Data & Mask Combine to Form Icon (fig. 3) - The example above shows how
an icon’s data layer (left), plus the icon’s mask (center) combine to form the
completed icon on the desktop (right). Because the pixels in the center and
exterior of the mask are white, the desktop image shows through the folder.

Although Mac & Windows support the same bit depths, their 4-bit and 8-bit palettes are not
identical. This is important when creating icons that will be seen across both platforms.
IconBuilder Pro comes with Photoshop .aco files (color swatches) of each platform’s tables
to help you optimize your cross-platform icons.
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From Idea to Icon

Like most things, creating an icon starts with an idea. That idea may be sparked by a need to make
a new application icon for a client or simply to make an icon for fun. A good way to start this
creation process is to sketch out your idea. Use the tools you are comfortable with whether it’s
paper and pencil, the computer, or fingerpaint– but get that idea down someplace! Sketching is
a good way to test the “visual waters” and see what works and what doesn’t within the confines
of a square iconic space. Plus, it’s much easier to draw several pencil sketches than it is to sit and
render a single icon in a vector program like Freehand or Illustrator.

Creation of the Base Art

Everyone has their own method for generating the graphics that will eventually become desktop
icons. Some like to use 3D modeling and rendering software. Some like to physically draw their
artwork with traditional media and then scan it into the computer. At The Iconfactory, almost all
icon creation starts with a vector-based drawing program, in our case Macromedia Freehand. Vector
art is referenced in this user’s guide, the accompanying tutorial PDF, and the EPS files that come
with IconBuilder. To get a better understanding of the icon creation process, you can use a vector
program like Freehand or Illustrator to open the EPS files and examine how they were created.

Developing base art for OS X icons begins with setting up a template square in Freehand that
measures 128x128 pixels. This gives the artist a bounding box or visual guide for the maximum
dimensions that the icon can occupy. Take note that if you plan on adding layer effects to the icon
in Photoshop, you should leave extra room so those effects don’t make your icon too large.

Next, choose the colors and line weights you intend to use in your icon and start to draw the
object(s) that will compose your creation. You will find that line weight becomes very important,
especially at the smaller icon sizes. A one point line may look great for a 128x128 icon, but will
probably disappear when you rasterize that art at 32x32 pixels. The more you practice this initial
drawing phase, the easier it will be to learn what line weights work well at what sizes. Draw a
portion of the icon, import it into Photoshop for viewing, and adjust it accordingly. Icons for Mac
OS X have a completely different style from those in Windows XP. Much of XP’s style comes from
line weight. To compare line weights and rendering styles, open the icon files that are included in
the IconBuilder Pro tutorial folder.

The use of color will also greatly determine how the final icon will look and whether or not it will
be successful on the desktop. Don’t be afraid to experiment with gradients and different directions
for light sources. Keep in mind however that if you are attempting to create a true “Aqua” icon,
Apple’s OS X Icon Guidelines state that all light sources should come directly from above and slightly
in front of the object in question. Lighting for XP icons should come from above and to the left
of the object to be rendered.

The Advantages of Using Vector-Based Art

There are many reasons why creating icons with a vector program like Freehand or Illustrator is
preferable over 3D modeling or even drawing directly in Photoshop. The greatest advantage is that
vector-based art is infinitely scalable.

If a client decides they want to use an icon for packaging or marketing purposes, then it is an easy
matter to generate a high-resolution EPS file from the vector art. By contrast, an icon that is created
pixel by pixel in Photoshop works best only at the size and resolution for which it was created.
Usually, standard screen resolutions (72 or 96 dpi) are too low for use in print. Also, keep in mind
that a standard OS X icon contains over 16,000 pixels. To draw or paint an icon by hand that
contains this many pixels requires a great deal of time and effort. In addition, making changes pixel
by pixel is much more difficult than altering a vector-based path or color fill.

At The Iconfactory, we design Mac OS X icons to have a maximum dimension of 120x120
pixels. Why is this? Icons that are 128x128 pixels may touch the edges of other icons when
they are placed next to each other in the Dock. Leaving extra “padding” around the icon
ensures that it has enough visual room to breathe.

Drawing an Icon in Freehand (fig. 4) - You can see how an idea goes from
concept to completion. The artist does numerous rough sketches (top) to determine
the best angle and composition for the folder to be rendered. Creation begins
in the vector program by drawing the basic outline shapes (middle) and then by
slowly building up layers of detail and color (bottom).
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Creating icons in a 3D program has its own set of problems as well. 3D modeling has the advantage
of easily changing camera angles and lighting choices, but the software is expensive, creating the
model is time consuming, and the resolution problem remains. If you need a version of the icon
larger than 128x128 pixels, you’ll have to re-render the image at the appropriate size and touch
it up accordingly. Lastly, creating convincing, natural objects using 3D modeling software is notoriously
difficult. Rendered 3D objects are usually constructed from variations on primitive shapes (cones,
spheres, cubes, etc.). As a result, icons created in this fashion can look static, cold, and mechanical.

Of course, different projects call for different approaches and what works for one person may not
work for another. In the end we encourage you to experiment and use the process and tools with
which you are the most comfortable.

Formatting the Base Art

Once you are satisfied with the quality and composition of the vector artwork, the next step is to
format the art to import into Photoshop and then into IconBuilder Pro. The base art can be imported
or “rasterized” into Photoshop in any number of ways, but we find that creating a Photoshop EPS
file of the artwork works best. Once you have the EPS file you can open it in Photoshop at the
appropriate size onto a transparent layer. Although an EPS file can be rasterized at any size, it’s
best to keep the resulting image as close to the original dimensions as possible. Doing so results
in a clean, sharp graphic and provides IconBuilder Pro with a strong starting point to create the
other icon sizes and bit depths.

The process of importing EPS files is covered in the IconBuilder Pro Tutorial that accompanies this
User’s Guide. We encourage you to review the tutorial step by step for more information about
EPS files and how to import them into Photoshop.

IconBuilder Pro comes with a Photoshop action that allows you to instantly resize and optimize
your 128x128 pixel base art for inclusion as an Mac OS X icon. The installation and use of
this action is covered later in this User’s Guide as well as the IconBuilder Pro Tutorial PDF.
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Locate IconBuilder Assistant (fig. 6) - IconBuilder Assistant is located in the
Goodies folder of the main IconBuilder Pro download under the  filename
IB Assistant.atn.

How To Install IconBuilder Pro

Drag and drop the IconBuilder Pro folder from the disk image you downloaded from The Iconfactory
into your Adobe Photoshop Plug-Ins folder. The Plug-Ins Folder should be located in the main
Applications folder of your Mac’s hard drive.

Loading IconBuilder Assistant (Photoshop Action)

The IconBuilder Assistant Photoshop Action file (IB Assistant.atn) included in the IconBuilder Pro
download is pre-built and ready to be loaded into Photoshop. Using IconBuilder Assistant can
greatly reduce the effort and time needed to construct Mac OS X icons by automatically creating
icon sizes from a base 128x128 graphic.

To load IconBuilder Assistant, launch Photoshop by clicking its application icon in the Dock. Once
running, activate the Actions palette by selecting Window > Actions from the main menu.

Next, click the small triangle on the top right side of the palette to access the menu options for
Actions. Select Load Actions... and a standard Mac OS X dialog box will open. (fig. 5)

Then, to locate the IconBuilder Assistant action file, navigate your hard drive using the following
route: Applications > Adobe Photoshop > Plug-Ins > IconBuilder Pro > Goodies > IB Assistant.atn
Select and click Load to import the action into Photoshop (fig. 6).

You are now ready to use IconBuilder Assistant. Simply select it from the Actions Palette or assign
it a command-key shortcut.

Loading Custom Color Tables (Optional)

IconBuilder Pro comes with custom color table files (.aco) you can use when designing your icons
for either the Mac or Windows platform. These files supply you with the Windows 16-color and
256-color palettes, the Macintosh 256-color palette, and others.

To load a custom color table, launch Photoshop by clicking its application icon in the Dock. Once
running, activate the Swatches palette by selecting Window > Swatches from the main menu.

Next, click the small triangle on the top right side of the palette to access the menu options for
Swatches. Select Replace Swatches... and a standard Mac OS X dialog box will open.

Then, to locate the IconBuilder Pro custom color table files, navigate your hard drive using the
following route: Applications > Adobe Photoshop > Plug-Ins > IconBuilder Pro > Goodies > Swatches.
Select  the .aco file you want to use and click Load to import the palette into Photoshop.

Once the table is viewable, you can use Photoshop’s eye dropper tool to select the appropriate
color for editing your icons.

Uninstalling IconBuilder Pro

To uninstall IconBuilder Pro, simply drag the IconBuilder Pro folder to the Trash. The folder should
be located on your hard drive in Applications > Adobe Photoshop > Plug-ins.

Load IconBuilder Assistant (fig. 5) - IconBuilder Assistant must be loaded from
within Adobe Photoshop before you can use it.
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About The Interface

The user interface of IconBuilder Pro is broken into three main sections: the Source Layer, the Work
Area, and Formatting / Save Options. It is important to know the difference between these areas
and understand their individual controls in order to get the most out of IconBuilder Pro.

Section a: The Source Layer - The Source Layer contains controls that allow you to manipulate
the content coming into the filter. You can align the image on the canvas, add the proper data or
mask to the Work Area (manually or with QuickBuild™), adjust the color palettes, and select a
color and pattern to view your work against. In addition, from the Source Layer you can access
helpful BuilderTips, jump to The Iconfactory website, and view version and registration information
about the filter.

Section b: The Work Area - The Work Area displays the individual resources that make up the
the current icon and how it will look after it is saved. The controls in this area allow you to choose
between two main view settings (Grid and Aqua), toggle between “icon states” for Mac OS X
icons, and customize how your icon’s data and mask are displayed. You also have the ability to
extract the currently viewed resource back into a Photoshop layer.

Section c: Formatting Controls - In addition to enabling you to open, convert, and save icon
files, the Formatting Controls allow you to clear all resources from the Work Area, import any icon’s
data and mask information, and choose the target format and operating system to save your work
in. From this area you can also register your copy of IconBuilder Pro and quit the filter to return
to Photoshop.

a b

c
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Controls of the Source Layer

1. About IconBuilder Pro - Click the title bar to view the filter’s About Box which includes the
current version number, credits, and registration information.

2. Weblinks Menu - Select items from this pull-down menu to surf to The Iconfactory website
and view additional IconBuilder Pro information. Check for the latest updates, read frequently
asked questions and learn helpful tips and tricks.

3. Add Data - Adds the visual information contained in the Source Layer to the currently selected
cell in the resource grid.

4. Add Mask - Adds only the transparency, or masking information, from the Source Layer to 
the cell currently selected in the resource grid. This control can be used to achieve some 
interesting transparent effects for icons on the desktop.

5. Add Both - Adds BOTH the visual data as well as the mask data to thecurrently selected cell
in the resource grid. This is the method that is most commonly used to add individual resources
into an icon.

6. Dither Icon - Toggle this control to turn color dithering on or off for the source image. The 
default dither setting is “off.”

7. Center View - Centers the current selection from Photoshop for easier viewing in the Source
Layer window.

8. Reset Grid - Resets the current view to the standard Quickbuild™ grid. This is useful when 
you have used the hand tool to manually reposition the current view and want to revert to 
the original grid positions.

9. QuickBuild™ - Instantly adds data and mask information to the entire working area. 
Shift-click this button to QuickBuild™ entire columns, and Command-click to QuickBuild™ 
entire rows. Hold down the Option key to Quickbuild™ all icon sizes (Grid & Aqua) at the
same time.

10. Palette Menu - Select a built-in color palette to work with from this pull-down menu. The 
default palette is always optimized for the current platform you have selected.

11. Background Texture Menu - Select a background color or texture to view your work against.
The Texture Menu comes with many of the default desktop colors from both the Macintosh 
and Windows operating systems.

12. BuilderTips - Displays helpful tips and file information. Click the Iconfactory icon to toggle 
BuilderTips on for filter help or off for miscellaneous file information.

The larger your canvas size and selection area in Photoshop, the more difficult it will be to
center your icon in the Source Layer. To help keep things manageable, we recommend placing
your icons in the default IconBuilder Pro Grid that came with the filter. If you prefer not to
use this file, just remember to try to keep your working area relatively small.

Viewing icons against dark backgrounds is useful for spotting masking problems. IconBuilder
Pro provides a number of background colors and textures to test your icon creations against
just for this purpose.

1

2

3

4

5

6 7 8 9
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11
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The Source Layer (fig. 7) - This section of the IconBuilder Pro interface contains
controls for formatting, adjusting, and adding your source art into the Work Area
to construct icons for Macintosh or Windows.
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Resource Grid Modes - The Resource Grid can be set to two distinct modes for
icon construction - Grid and Aqua. In Grid mode (fig. 8) you can view, add or
remove the default icon sizes of 16x16 pixels, 32x32 & 48x48 as well as their
associated bit-depths. You can then switch to Aqua mode (fig. 9) to view, add or
remove the 128x128 thumbnail icon used in Mac OS X. When building for Windows,
Aqua mode is disabled.

Controls of the Work Area

1. “Icon State” Controls - Toggle between the Normal and Open / Drop states with these 
buttons and add individual resources accordingly. When used in conjunction with the
Save Options > Save as Folder control, this feature creates an icon on the Mac desktop that 
displays “icon states” properly. See glossary for description of “icon state.”

2. Resource Grid / Aqua - The Resource Grid is organized by icon sizes in columns and color 
bit depths in rows. Different platforms have different size and bit-depth requirements
(see fig. 2), so the entire grid will not always be filled in. You can add resources to the grid 
one-by-one with the Add Both button or all at once with QuickBuild™. The Grid converts to
Aqua mode (see figs. 8 & 9) to add the 128x128 thumbnail resource needed for Mac OS X.

3. Target Icon Window - Displays the currently selected resource from the grid. This is useful 
to see how the final resources behave against different color backgrounds, to spot masking 
problems, etc.

4. Resource Protection - Helps you “lock out” resources that will not be needed for the platform
that is currently selected. This helps optimize icon file sizes and avoid backward compatibility
issues by excluding older, unwanted resources.This button toggles, but is active by default.

5. Undo - Reverts the currently selected resource to its previous version.

6. Delete - Removes any data or mask info from the currently selected grid cell. You can also 
select the grid cell you want to remove and press the Delete key.

7. Apply View to Photoshop Layer - Extracts the target icon file (data, mask, or both, 
depending on which tab is currently being viewed) to the currently selected Photoshop layer.

8. Grid / Aqua Tabs - Click the Grid tab to view and build classic icon resources, or click the 
Aqua tab to view and build Mac OS X thumbnail (128x128 pixel) resources. (see figs. 8 & 9)

9. Both / Data / Mask Tabs - The Both tab displays the icon in the Target Icon Window as it 
would appear on the desktop. The Data tab displays only the visual data of the target icon 
file. The Mask tab displays only the mask of the target icon file.

1

2 3

4 5 6 7

8 9

“Grid Mode” (fig. 8) “Aqua Mode” (fig. 9)
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When building a desktop icon that contains an Open / Drop state, you MUST use the Save
Options to set the save format to Folder with Custom Icon. Saving the icon as a standard
resource file will not format the icon correctly and you will not see the Open / Drop state
function in the Mac OS X Finder.

However, since IconBuilder Pro cannot read the states from an icon saved in this fashion, we
recommend that this is the final step you perform when constructing Open / Drop folders.

Formatting Controls & Save Options

1. Platform Menu - Select either Macintosh or Windows as the target icon platform.

2. OS / File Type Menu - Select the specific target operating system(s) for which to save your 
icons. For best compatibility, we recommend that you always leave this set to “All.” There are
times however, when it is necessary to save .icns developer files for the Mac.

3. Save Options - Opens the Save Options dialog box. (fig. 10)

4. Quick Convert - Automatically converts an opened or imported icon to the opposite platform.

5. Clear - Clears all resources from the Work Area.

6. Import - Imports any desktop icon’s data & mask into the Work Area.

7. Open - Opens any previously saved IconBuilder icon file.

8. Save - Saves your icon for the platform, operating system, and options currently selected.

9. Register - Click this button to purchase IconBuilder Pro online and enter your
registration information. This button disappears once the filter is registered.

10. Done - Quits IconBuilder Pro and returns you to Photoshop.

11. Save Format Menu - Use this pull-down menu to select the save format for the icon to be 
built. The default selection is Resource file document. When saving a desktop icon with states,
you should set this menu to Folder with Custom Icon.

12. Custom Icon Checkbox - Applies the icon you are creating to the resource file so that the 
icon represents the file in the Finder. If not selected, no icon will represent the resource file in
the Finder. The default for this option is on.

13. Resource ID Field - Saves resource file icons with custom resource ID numbers if you want. 
We recommend leaving this field in its default state.

14. Additional Resources - Includes additional resources not commonly needed for desktop 
icons.Unless you are an advanced developer, we recommend you do not check this option.

15. Defaults - Reverts the Save Options settings to factory defaults.

1 2 3 4

5 6 7 8 9

10

11

12

13

14

(fig. 10)
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Tips for Building Open / Drop State Icons

There are a few helpful tips to remember when creating icons with Open / Drop states for Mac
OS X. The most important tip is that in order for the icon to function properly in the Mac OS X
Finder, you must use the Save Options in IconBuilder Pro to save the icon as a folder with a custom
icon. This way, when something is dropped onto the folder in the Finder, you will see the folder
animate or change to the open state. Other things to remember include aligning the icon properly
on top of its normal state. If the Open / Drop state is out of alignment, even slightly, the user will
see the icon move or “jump” when dropping a file onto it. Use IconBuilder Pro’s nudge controls
(the arrow keys) to make precise adjustments to the position of the Open / Drop state.

Know The Target Platform

Before even one pixel is pushed, you should identify the platform and operating system on which
the icon will be seen. Why is this important? There are different color considerations when creating
icons between the Macintosh and Windows platform, or even between OS versions on these
platforms! A Mac OS X icon has widely different properties than an icon built for Windows 98 or
NT and so on. Know where the icon will be seen and used before you start and design accordingly.

Advantages of Photoshop Layers

Many times when creating icon suites for software, a developer will create a single “base” icon
as the template for the set. Then multiple variations are designed on that icon to composite as
needed. In situations like this, the advantages of IconBuilder Pro and Photoshop become clear.

Because Photoshop layers can be created, moved, rearranged, and have their opacity level set at
will, they become the ideal environment for creating large, slightly varied sets of icons. Create your
base “folder” icon on one of the lower layers, then add layers for each type of element you’ll need
to apply to the base folder. We call this “badging” because you are essentially adding a smaller
icon or “badge” to the larger parent icon. (see fig. 11) Badges can even be used to represent the
icon itself in the smaller 16x16 (or list view) version.

One thing to remember when compositing, IconBuilder Pro will only recognize the data in the
currently selected layer. You’ll need to merge or duplicate the multiple elements into a single, new
layer prior to launching the filter. The same applies for Layer Effects and setting the opacity levels
of a given layer when masking. Just remember to turn off the background layer prior to merging
(if you’ve not already deleted it).

Name and Save Your Layers

Using Photoshop and its multiple layers for compositing and building icons is a time saver, but not
if you can’t find the layer you’re looking for. Try to name a new layer as soon as you create it. This
will help later when you’re looking for the badge of “that widget” and all of a sudden you have
60+ layers with 16x16 badges on them.

Consult Apple & Microsoft’s User Interface Guidelines

If you’re using IconBuilder Pro, then chances are you are designing icons for corporate clients or
software developers or both. When designing and building icons for Mac OS X or Windows XP, it
is imporant to consult the GUI guidelines each company has set up for designers so that their icons
look like they “belong” in their respective operating systems. Now, we’re not saying that these
guidelines should be followed to the letter, but when you have a client that needs solutions for
these operating systems, at the very least, keep the guidelines in mind. For the latest information
on these design guidelines, use the Weblinks feature built into the filter to have your browser take
you to the appropriate guidelines for each platform.

Check Out the IconBuilder Pro Tutorial & Website

A step-by-step tutorial is part of your IconBuilder Pro download. Use it to familiarize yourself with
the controls and features of this powerful filter through hands-on practice. The tutorial is divided
into three sections that cover creating Mac OS X icons, creating Open / Drop states for Mac OS X
icons, and creating Windows XP icons.

Still hungry for more information about IconBuilder Pro and the world of icons? Check out our
website at www.iconfactory.com for all the latest news about the filter and beyond.

“Badging” Folders (fig. 11) - Here, a base folder is placed near the bottom
of the layers list, while the smaller elements or “badges” are placed above. In
this way, badges can be combined, blended, made transparent, etc. to achieve
a range of effects.
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A User’s Guide to Understanding the Filter
IconBuilder Pro Keyboard Shortcuts / Registration

If you prefer to order IconBuilder Pro over the phone, please call
The Iconfactory Monday-Friday 9am-5pm est. at 336.299.5251 and
follow the prompts to reach the sales department.

The following controls in IconBuilder Pro have modifier keys which extend
the built-in features of the filter. Becoming familar with these keyboard
shortcuts will greatly improve your productivity when building icons with
IconBuilder Pro.

Pressing and holding the Option key, allows you to skip the warning for
discarding changes with the following controls: Clear, Import, Open, Apply
and Done.

The Option key also allows you to center all resources sizes (both Grid view
and Aqua view) when used in conjuction with the Center Icon button and
the Reset Grid button.

Pressing the Option key in association with QuickBuild will automatically
add ALL resources to the currently selected icon state (both the Grid view
and Aqua view). The same is true of Revert and Delete.

Pressing and holding the Shift key allows you to modify all of the resources
of the same size (grid row) at the same time. So, holding Shift + Quickbuild
will auto-build an entire row in the Grid view. Shift + Delete will delete the
entire row, and so on.

Pressing and holding the Control key allows you to modify all of the
resources of the same bit-depth (grid column) at the same time. So, holding
Command + Quickbuild will auto-build an entire column in the Grid view.
Command + Delete will delete the entire column, and so on.

Select any resource grid cell and press the Delete key to remove it.

Press the Up, Down, Left or Right Arrow keys to nudge the placement of
the base art in the Photoshop Layer window.

Registering IconBuilder Pro

If you use IconBuilder Pro, you must send in your registration fee. The cost
to register IconBuilder Pro for a single user is $69.00 USD. To register the
filter, press the Register button that is located above the Done button at
the bottom of the user interface.

A new window will appear with a Submit Payment button. When you
press the button, you will be taken to a secure on-line ordering page where
you can purchase the software. The on-line order form allows you to pay
with a credit card, check or cash.

Paying with a credit card is the quickest method to submit your payment.
Also, since the on-line transaction is secure, your credit card number is
protected. After your payment is received and processed, The Iconfactory
will send a registration number via e-mail. Normally, this takes one to two
business days.

Entering Your Registration Code

Click the Register button within IconBuilder to open the register dialog
box. Enter your name, product code and number exactly as it appears in
the e-mail you received from The Iconfactory. After pressing OK, the
program should thank you for registering. If you see an error message,
check that the information in the e-mail matches the data you entered in
the fields. Make sure that the case of the characters matches and that
there are no extra spaces at the beginning or end of the input fields.

Option Key

Shift Key

Control Key

Delete Key

Arrow Keys
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IconBuilder Pro Glossary of Terms

The number of bits used to store information about each pixel. The higher
the depth, the more colors are stored in an image. For example, the lowest
bit-depth, 1 bit graphics are only capable of showing two colors, black &
white. This is because there are only two combinations of numbers in one
bit, 0 and 1. Four bit color is capable of displaying 16 colors because there
are 16 different combinations of four bits, and so on. When bit depth
refers to an image, it means that the image may contain the specified
number of colors.

The attempt made by a computer program to approximate an exact color
from a mixture of secondary colors when the required color is not available.
For example, dithering occurs when a color is specified for a Web page
that a browser on a particular operating system can’t support. The browser
will then attempt to replace the requested color with an approximation
composed of two or more other colors it can produce. The result may or
may not be acceptable to the graphic designer.

Abbreviation of Encapsulated PostScript. EPS is the graphics file format
used by the PostScript language. EPS files can be either binary or ASCII.
The term EPS usually implies that the file contains a bit-mapped representation
of the graphics for display purposes.

In Photoshop and other graphic applications, a filter is a particular effect
that can be applied to an image or part of an image. Filters can be fairly
simple effects used to mimic traditional photographic filters or they can
be more complex programs like IconBuilder Pro which is used to create
icon files.

Abbreviation of Graphical User Interface. A graphical way to represent the
operating system, application, software, etc.

Mac OS 10.2 introduced the use of “icon states.” This allows an artist to
design and produce icons that change visually when certain things happen
in the Finder. As of Mac OS 10.2.3, the only states currently supported by
Apple are Normal and Open / Drop. The Open / Drop state displays an
alternate version of the icon when a folder or file is dragged and dropped
onto it. This is very effective for folder or application icons as they appear
to “animate” as users drop files onto them.

In relation to icon design, masks are areas of a graphic that are defined
to be transparent or semi-transparent rather than opaque. A pixel’s mask
can be set to any of 256 levels of gray, with a value of 0 (black) being
completely opaque and a value of 255 (white) being completely transparent.
In this way, a graphic can have an edge treatment that appears to blend
or anti-alias to the background on which it is contained.

Abbreviation for picture element; a dot that represents the smallest graphic
unit of display on the screen. A typical VGA screen has a resolution of 640
pixels (screen width) by 480 pixels (screen height).

The process of converting a vector graphic to a bitmap which creates a
fixed-size raster graphic from the  scalable vector graphic. The interpretation
of an image from a set of digital codes into an actual visual representation.

The bitmap graphics you create for the various bit depths and pixel sizes
when building an icon. Each resource contains the icon’s data and mask
information. Individual resources are collected and saved to form the final
icon file to be used by the operating system.

The creation of digital images through a sequence of commands or
mathematical statements that place lines and shapes in a given two-
dimensional or three-dimensional space. For example, instead of containing
a bit in the file for each bit of a line drawing, a vector graphic file describes
a series of points to be connected.

Bit Depth

Dither

EPS

Filter

GUI

Icon States

Mask

Pixel

Rasterize

Resources

Vector Graphics
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